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Preface

This book is intended for beginners who have little or no knowledge of Win-
dows or programming. It provides a relatively broad but not very deep cover-
age of Visual Basic 3.0 for Windows, Standard Edition. It is a slimmed-down
version of its fuller (850-page) incarnation, The Visual Basic Coursebook.

Chapter 0 supplies the basic information on Windows 3.1. Since Visual Basic
is used to write programs for Windows, you need some knowledge of Win-
dows to be productive with Visual Basic.

The remainder of the book is divided more or less equally between Visual
(designing user interface) and Basic (programming language). By the time
you finish, you should be fairly proficient in Visual Basic.

Compared to a similar-sized book, this book covers much more Visual Basic
features. To provide room for breadth in limited available space, depth is
often sacrificed. Fortunately, there is ample online help supplied by Visual
Basic. You'll be pointed out on proper occasions how to tap into this vast and
helpful resource at your fingertip. So the book should get you started on a
solid footing and help launch you to a higher altitude.
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PC, DOS, and Windows

This chapter tries to accommodate the complete novice who knows little or
nothing about computers. Think of the 0 in the chapter number as a non-
credit remedial course you have to take before you can enroll in a credit
course. You need to know what is covered here before you can effectively
learn to use Visual Basic. If you already know this stuff, you can simply
ignore this chapter and move on to the next.

When you turn on your PC (personal computer), DOS (disk operating sys-
tem) is booted (started). Windows then runs on top of DOS. A Windows-
compliant program like Visual Basic then runs on top of Windows. As a
Visual Basic user, you need to know a little about what lies underneath it.
This chapter will concentrate mostly on Windows because you are likely to
have more interaction with it than the layers below.

PERSONAL COMPUTER

A PC consists of the main parts shown in Figure 0.1 The system unit con-
tains a CPU (central processing unit, the electronic brain), RAM (random-
access memory) for temporary storage of data, a motherboard to integrate all
the parts, controller cards (boards) with electronic circuitry to connect to
peripherals such as modem (for sending and receiving electronic messages),
printer, keyboard, and so on. Inside the system unit, there is usually a hard
disk (also known as a hard drive) and one or two floppy drives, which have
openings for you to insert floppy disks (diskettes) to save data.
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Figure 0.1 A personal computer

The keyboard is an input device. You type something and press Enter to
give an instruction to the PC. The PC keyboard has a row of 12 function
keys marked F1-F12. These keys are used by different programs for different
purposes. The Caps Lock key turns on/off uppercase letters. The Num Lock
key turns on/off the numeric keypad on the right side of the keyboard. When
on, pressing a key here displays a number on the screen; when off, the arrow
(cursor-control) keys are activated. The Shift, Ctrl, and Alt keys are combined
with other keys for a variety of purposes.

The monitor is an output device. It displays what you have done and what
the PC is doing in response. In a graphical program, the objects on the screen
can be maneuvered with a mouse, which is another input device like a key-
board.

To store your own data, you need to be equipped with floppy disks. These
come in two sizes, 5.25 inch (Figure 0.2) and 3.5 inch (Figure 0.3). These are
not compatible; a 3.5-inch disk cannot be used by a 5.25-inch drive. If your
PC has two different floppy drives, you can use either type of disks. If it has
only one drive, you must have the exact matching type of floppy disks.

Each floppy disk has a write-protect device, shown at the top right of the two
figures. On a 5.25-inch disk, you cover this hole with an adhesive tape to
prevent writing data to the disk or erasing the existing data. On a 3.5-inch
disk, you slide the built-in tab to the edge to show a see-through hole to
write-protect the disk.
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Figure 0.2 A 5.25-inch diskette
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Figure 0.3 A 3.5-inch diskette

Most floppy disks for sale today come preformatted; they are ready to store
data without your having to do anything. If they are not formatted, you need
to use the DOS FORMAT command to format it; see the next section.

DISK OPERATING SYSTEM

Each PC has a BIOS (basic input/output system) chip that contains instruc-
tions. When the PC is turned on, the instructions load DOS into memory. The
DOS system prompt then appears as below:

C:\>_
This is the DOS command line. The blinking underscore character known as
the cursor is where you can enter a command to tell DOS what to do next.
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The system prompt usually consists of the drive's letter (C:), the current
directory (\ represents the root directory) and the > sign. The first two will
change if the current drive or directory (also known as a folder) is changed.
For example, you can enter this command (type the command shown and
press the Enter key) to show the result in the second line:

c:\>cd \dos

C:\DOS>_
To return to the root (the highest) directory, enter this:

c:\DOos>cd \

C:\>_
You can change the current drive by entering a drive letter followed by a
colon. Put a disk in drive A and enter this:

C:\>a:

A:\>_
To show the files (data) stored in a disk directory, use the DIR command,
like this:

A:\>dir
DOS has numerous commands. The following are commonly used:

ATTRIBUTE Shows or changes file attributes.

FORMAT Prepares a disk for use by DOS.
CD Changes directory.

COPY Copies one or more files.

DEL Deletes disk files.

DIR Shows directory information.
DISKCOPY Copies an entire disk.

MD Makes (creates) directories.
PROMPT Shows or changes command-line prompt.
RD Removes directories.
SCANDISK Diagnoses and repairs disks.
TYPE Displays a text file's contents.
UNDELETE Restores deleted files.
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WARNING FORMAT, COPY, DEL, and DISKCOPY can destroy data
® stored on a disk. Before you use these commands, make sure you
know what you are doing. Never use FORMAT on a hard disk un-
less you are absolutely sure.

DOS since version 5 comes with an online help. If you are not familiar with
DOS, you should take full advantage of it. To get an abbreviated help, enter
this:

c:\bDos>dir /?

The above command consists of a DOS command name followed by a slash
and a question mark. To get the full help, enter this:

Cc:\DOs>help dir

If you don't know a command's name, just enter HELP alone. The resulting
screen will show you all the names, which you can choose to show a series
of related screens. When you are done, select Exit from the File menu and
you will be returned to the DOS command line.

WINDOWS DESKTOP

If your hard disk has Windows installed, turning on the PC will boot DOS,
and the batch file named AUTOEXEC.BAT will automatically load Win-
dows. If this is not the case, you need to go to the C:\WINDOWS directory
and load Windows like this:

c:\>cd \windows
C: \WINDOWS>win

After a while, the initial Windows screen appears, as shown in Figure 0.4.
This is the Windows desktop.

The central theme of Windows is to let the user open a series of windows
and switch from one to another to perform different tasks. All these begin
from the Windows desktop. Your monitor screen is treated as a desktop and
objects are displayed and arranged as you would on your desktop.

Keep in mind that the Windows desktop is like a chameleon. It can be
changed many ways. What is shown here may not resemble what your screen
will show. If you wish, your screen can be made to look like this.
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Figure 0.4 The Windows desktop

The outer window is the Program Manager window. It can contain other
windows, icons, menus, and other objects. Here are the major components
and what you can do with them:

Title bar Each window has a title bar. You can drag this bar to move the
entire window. This is the easiest way you to move a displayed window.

Menu bar Some windows contain a menu bar. In that case, you can
choose a menu option to execute a command.

Control-menu box Each window has a control box at the top left corner.
Double-clicking it closes the window. You may be prompted to save data
or with a Yes/No prompt. Clicking the control box displays a menu,
which will be explained shortly.

Minimize/Maximize button  You can click these triangles to reduce a win-
dow to an icon or expand it to fill up the entire screen. When a window
is maximized, a restore button (combining both triangles) appears; you
can click it to restore the window's original size.
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Borders The borders are marked by double lines. When you move the
pointer over a border, the pointer becomes double-headed. You can then
drag it to change the window's size. When the pointer is over a corner,
the double head becomes slanted. You can then drag it to resize the win-
dow both horizontally and vertically.

Group window A group (or program-group) window, such as Main, con-
tains a group of related programs. It has no menu bar. Such a window
can be created by the user or by a program during its installation. You
can use the File menu to modify or delete such a window.

Group icons When a group window is minimized, it becomes an icon. All
group icons are identical. A label directly below each icon distinguishes
it from another. You can double-click a group icon to expand it to its
original size. A group icon can be dragged to any location inside the
Program Manager window. It will stay where you put it. If this window
becomes messy, you can choose Arrange Icons from the Window menu.
All the icons will then be neatly rearranged.

Program-item icon Each program in a group window is represented by a
distinct program-item icon. Each icon can be dragged to a new location
inside the same window; some items may be automatically rearranged.
You can double-click such an icon to run a program. That program then
appears in a separate window with a menu bar and other accessories.

Scroll bars A window may have a horizontal and/or vertical scroll bars
when items are only partially displayed. If all the items are fully dis-
played, then no scroll bar appears. You can drag the displayed scroll box
to display more items. You can click the up and down arrows to move
by small increments or the area above or below the scroll box to move
by larger increments (faster).

NOTE You can double-click a window's title bar to toggle (switch)
between the normal size and the maximized size. Each time you
double-click, the window is switched to the opposite size.

When multiple windows are open, only one can be active. Its title bar is
highlighted. It may also cover up other windows. You can make a window
active by clicking any exposed area of that window. This will bring it to the
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top (foreground) of multiple overlapping windows. To switch to hidden win-
dows, use the techniques discussed in the next few sections.

" TIP: Mousing Around

If you are new to a graphical user environment, you need to get familiar
with some of the basic terms and techniques of using a mouse, which
is commonly used to control that environment.

« The pointer or mouse pointer is an arrow that appears on the
screen. You can roll the mouse ball to move the pointer.

» Clicking an object means moving the pointer to the specified ob-
ject, pressing the left mouse button and releasing it.

« Double clicking requires pressing the same button twice in rapid
succession.

 Dragging requires holding down the left button and rolling the
mouse to a desired location. The involved object will move as you
drag it. Release the button when the object arrives at the desired
location.

Two Types of Windows

There are two types of windows, application window and document win-
dow. The latter is a subsidiary (child) of the former. When you run a pro-
gram, a word processor for example, an application window is opened. When
you open different windows to write different letters, you open document
windows.

There are two ways to distinguish these two types of windows. An applica-
tion window has a menu bar, but a document window does not. An applica-
tion window's control-menu box has a horizontal bar that is longer than the
counterpart in a document window.

Figure 0.4 shows Program Manager as an application window and Main as
a document window. If you click Main's Minimize button, it will be reduced
to an icon inside its application (Program Manager) window.
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If you maximize a document window, it fills up its the application window.
Figure 0.5 shows Main maximized. The combined title bar—Program Manag-
er - [Main]—clearly shows the merger. The Restore button also appears. If
you click it, the Main window will be restored to the size before maximizing.
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Figure 0.5 A maximized application window

As stated earlier, only an application (not document) window has a menu bar.
The sole menu system can be applied to everything inside the application
window. So if you want to do something to the Main window, use the menus
in the Program Manager window.

When an application window is minimized, it is reduced to an application
icon. Each application icon has a unique picture and a unique label. Figure
0.6 shows three application icons at the bottom of the screen. Notice that they
are outside the Program Manager window. If we minimize the Program Man-
ager window, its icon will be added to the bottom and the screen will be
mostly empty.

A minimized application icon is initially placed at the bottom. You can drag
an application icon to anywhere on the screen except inside another window.
It will stay there even after you activate the application and minimize it
again. To activate a minimized application, just double-click it.



